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For LibraryLinkNJ Membership
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This document guides you on how to use the LibraryLinkNJ web site. It explains
how to complete certain tasks. If you have any questions, please contact
Mi-Sun Lyu at lyu@librarylinknj.org.
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1. Brief Introduction

The LibraryLinkNJ website (http://www.librarylinknj.org), launched in April 2011, is based on Drupal, an

open source content management system. Drupal gives registered users certain privileges to customize

the web site’s functionality to meet their specific needs. The website is also using a civiCRM module (an

open source software constituent relationship management solution), which provides an integrated

solution for the event management system and member data updates.

-
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LibtraryLinkNJ.org

Users will be assigned a role depending on their user account status and their responsibilities in their

library. Here are the three most important defined roles of General Users for LibraryLinkNJ:

User Role

Accessible Tasks

Anonymous
(no user account)

Can only view content that is marked for public viewing
Forum content will not be visible to anonymous users.

Authenticated
(users with an
account)

Update own user information and reset password.

Register for events (all event types including Continuing Education
programs). With the new site launch, we only take event registrations
online.

View and Participate in forums.

Make comments.

Use any online forms in the future.

Primary Contact
(users with an
account and
listed as the
primary contact
for their library
on our website)

All Accessible Tasks for Authenticated User, plus the following:

Update their library information (except for Delivery ID, Delivery Frequency,
and Voting Rep)

Report the library’s monthly delivery stats (New delivery stat report
requirements are posted on the website.)

See more details about accessible tasks of authenticated users & primary contacts on page 6.
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If you have any questions about performing a specific task on the LibraryLinkNJ website, please do not

hesitate to contact Mi-Sun Lyu (lyu@librarylinknj.org).
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Heads-Up and Important Notices about the
LibraryLinkNJ Website Launch

LibraryLinkNJ is excited to announce that we will launch our new website by mid-
April. After the launch, the way you use the LibraryLinkNJ website will change. A
document and pessibly a screencast of the step-by-step instructions on how to use
the website will be posted on the front page. Members can also participate in one of
three webinars that we will schedule to help users become familiar with the new
‘website structure, following the website launch. We expect the current listserv
structure to be in place for 30-60 days following the website launch.

Please note that the website is still under its final production, so please be patient
until we announce the launch.

» Read more

LibraryLinkNJ - Update for Membership
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5. CONTENTS "

» Readmare

Request for Proposal: LibraryLinkNJ - Statewide
Delivery System

The purpose of this Request for Proposal is to solicit proposals from qualified firms and
organizations to provide delivery of library materials for public, school, academic,
snarial and inctitutinnal lihrariac that ara mamhare nf lihrand inkhl| = Tha Mouwr larcan
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part of the New Jersey Library Network and serves every County in the State of New
Jersey. Bidders must meet the requirements as described within these specifications.
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The On-site, On-Demand Continuing Education
Program for School Librarians

LibraryLinkNJ will subsidize program costs for school library groups!
Let us Help You Make a Difference!

In these tough economic times, LibraryLinkM) is here for you. We know that ongoing
professional education is essential, and we want to make it as efficient and cost-
effective as possible. We will subsidize the program cost of the workshop you select!
The continuing education consultants we are working with have developed high-
interest, proven continuing education programs which address the specific needs of
school librarians.

» Read more

On-site, On-Demand Staff Development
FY11 Offer for Members of LibraryLinkNJ, the New Jersey Library Cooperative.

Let us Help You Make a Difference!

In these tough economic times, LibraryLinkNJ is here for you and your staff. We know
that ongoing professional education is essential in the work lives of alf staff members,
and we want to make it as efficient and cost-effective as possible. We will subsidize
75% of the program cost! We have contacted several consultants and consulting firms
specializing in p | devel They have developed high-interest, proven
continuing education programs especially for teams of staff members.

» Readmore
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1. LOGO & BANNER IMAGE

Currently a temporary logo and banner image are displayed.
We will update this section when we have our new logo.

2. USER ACCOUNT & RSS FEED

Text link to log in or to create a user account
RSS Feed - You can subscribe to this feed to receive updates when website content changes.

3. TOP MENU BAR

Links to frequently used menus are listed.
See more details under “Navigation Structure” on page 5.

4. LEFTSIDE BAR

Navigation: See more details under “Navigation Structure” on page 5.

User Login: Log in; Create a new account; Request new password

Direct Links: Only listed on the Front Page. Links to Statewide Free Database Page; Weather
Closing Form for No Delivery; JerseyCat; QandANJ; and JerseyClicks.

5. CONTENTS

LibraryLinkNJ Announcements/News

6. RIGHTSIDE BAR

Only listed on the Front Page.

Upcoming Events: Lists three upcoming events. Click ‘more’ text to see the full event list or
‘Calendar’ on the top menu bar.

Event Cancellation: This block will be visible only when there is a cancelled event.

Follow Us: Link to LibaryLinkNJ’s Facebook Page (www.facebook.com/LibraryLinkNJ) & Twitter
(@LibraryLinkNJ).

LibraryLinkNJ Flickr Photos: Link to photo albums on the LibraryLinkNJ Flickr page.

7. FOOTER & ATTRIBUTION

Footer: LibraryLinkNJ Office Information

LibraryLinkNJ Website Use Policies

Attribution: LibraryLinkNJ, The New Jersey Library Cooperative, and its services are funded by
the New Jersey State Library, which is responsible for the coordination, promotion, and funding
of the New Jersey Library Network.



I Guidelines for Using the LibraryLinkNJ Website: www.librarylinknj.org April 2011

3. Navigation Structure (Menus)

TOP MENU BAR

Home LibraryLinkNJ Website Home Page (Front Page)

Calendar LibraryLinkNJ Event List in Calendar View; Link to the list in Table View

CE General Information on Continuing Education; Class Listing

Delivery General Information on Delivery Service; Delivery List; Delivery Labels; Stat Report
Discounts General Information on Group Discount Offers; Discount Offer List

Forums Member Forums: Only Authenticated Users can view and participate in Forums
Contact Us LibraryLinkNJ Contact Information

Search Box Searches the LibraryLinkNJ Website

LEFT SIDEBAR MENUS: NAVIGATION

About Us Overview on LibraryLinkNJ, including Documents
Staff LibraryLinkNJ Staff Information
Directions Directions to LibraryLinkNJ Office

Board | Task Forces

Executive Board & Task Forces Information

Executive Board

Executive Board Meeting Dates and Member List

Delivery Advisory Task Force

Task Force Purpose and Member List

Interlibrary Advisory Task Force

Task Force Purpose and Member List

Technology CE Advisory Group

Group Purpose and Member List

Website Advisory Task Force

Task Force Purposes and Member List

Continuing education

General Information about Continuing Education

Class Listing

Continuing Education Class Listing

Membership

How to Join LibraryLinkNJ

Member Search

Search Member by Library Type, County, & Alphabetical List

Voting Reps

Voting Representatives — Alphabetical List by Library Name

Projects

List of Current and Past Projects of LibraryLinkNJ

Library community

Library Related Organizations in New Jersey

My Account (These menus show
up after you log in.)

Create Contents

Log Out

Your User Profile; Update Profile; View Your Activities

List of Content Types that you have access to create

Log Out
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4. How do | create a user account?

Any staff member or affiliated person (such as a trustee or a commissioner) from a LibraryLinkNJ

member library can create a user account.

Go to http://www.librarylinknj.org.
Click “Create new account” under “User login” on the left side bar or on the top right of the

page.

You will be asked to create a username and enter your work information as below:

Username: You can set your username to be anything as long as it is unique. Please
keep in mind that your username will be displayed to others when you post forum
topics, leave comments, or participate in other ways online.

Email address: You MUST use your work email address to create your account in order
to authenticate your identity. If you want to use your personal email address, you can
edit your email address once your account registration is completed. If you do not have
a work email address, please contact Mi-Sun Lyu at lyu@librarylinknj.org. If you are the

primary contact of your library, however, please keep your work email address for your
account in order to update your library’s information and report your monthly delivery
stats.

Library Affiliation: Your Library’s Name; this is an autocomplete field, so you need to
type in your library’s name as it is listed on our member search page. As you type in
your library’s name, possible library names will automatically be suggested. Select your
library from the list (see the image below). If your library is a LibraryLinkNJ member but
it is not listed on our member search page, please contact Mi-Sun Lyu at
lyu@librarylinknj.org.

Log in Create new account

The New Jersey Library Cooperative

HOME CALENDAR CE DELIVERY DISCOUNTS FORUMS CONTACT US Search I

T Home » User account
Navigation
About Us
User account
Board | Task Forces -
Create new account Login Request new password
Continuing Education ~Account information
Membership Usexriame:®
Projects myusemame

Library Community Spaces are allowed; punctuation is not allowed except for periods, hyphens, and underscores

E-mail address: *

myworkemail@address.com

Avalid e-mail address. All e-mails from the system will be sent to this address. The e-mail address is not made public and will only be used if
you wish to receive a new password or wish to receive certain news or notifications by e-mail.

Name and Werk Information

Library Affiliation | ibrany ) p]

Non Member y y of Burlington
Organization [ LibraryLinkNJ

fyou do
"No Library" in

at a member library, please fill out your organization name. If you are not currently employed, please type

s field.

Work Phone: Your direct work phone number

First Name: Your First Name

Last Name: Your Last Name

Job Title: Select a job title that is closest to your current job title.
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- Job Responsibility: Select your primary job responsibilities that apply.
- Are you the voting rep for your library: Itis set to“No” by default. If you are the voting
rep, please check “Yes.”
- Are you the primary contact for your library: Itis setto “No” by default. If you are the
primary contact, please check “Yes.”
- Allinformation is required so that we can serve you better.
- Click “Create new Account” button at the bottom.
Once you submit your account registration form your account will be activated, pending the
approval of the site administrator, and a welcome message with further instructions will be sent
to your email address.
The site administrator will approve your account normally within 1 to 2 business days of your
submission. (During the month of April 2011, the pending time may be longer due to the
volume of new account creation.)
Upon the administrator’s approval, a notification email with a link to complete your registration
will be sent to your email address.
Click the link in the email to finish your account registration. You will be asked to create your
own password. Do that and your registration is complete.
If you have any problems with creating your user account, please contact Mi-Sun Lyu at
lyu@librarylinknj.org.

5. | forgot my password. How do | change my password?

LibraryLinkNJ’s new website provides a secure way for you to reset your password at any time.
If you need to reset or have forgotten your password, go to our website
http://www.librarylinknj.org.

Click “Request new password” under “User Login” on the left side bar. Or click the “Log in” link
at the top right of the page. Then, select “Request new password” tab next to “Log in” tab.
Provide your username or email address that is associated with your user account.

Replacement log in information email will be sent to your email address.

Click the link in the email to reset your password. Remember to click the ‘Save’ button after you
type in your new password.

6. How do | edit my LibraryLinkNJ account info, including email?

After you have logged in to your account, click “My Account” on the left side bar and then click
the “Edit” tab next to the “View” tab under your username. Under the “Edit” tab, you can select
the “Account” or “Name and Address” tabs to update your account information.

Or, you can click “Edit” on the top right of the page next to: “You are logged in as your
username”

You cannot edit your username. If you forget your username, follow “How do | change my
password?” instructions above. Once you log in with your new password, your username will be
displayed. If you need to change your username, please contact Mi-Sun Lyu at
lyu@librarylinknj.org.
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7. How do | register for an event or cancel my registration (for a meeting, CE class,

etc.)?

You have to log in to register online for any event. Please note that LibraryLinkNJ takes online
registrations only. You must have a user account for our website to register for any of our CE
programs or other events.

Find the event for which you want to register. You can either click “Calendar” on the top menu
bar or “more” under the “Upcoming Event” block on the right side bar on the front page. You
can view the event list in either Calendar or Table view by clicking the “Switch...” text link on
either page.

For Continuing Education programs, you can also click “Class Listing” under the “Continuing
Education” menu on the left side bar.

Click the “CLICK HERE TO REGISTER” link on the event information page. Then, confirm the
event name and date and click the “Register Now” button. Your email address and information
will be automatically filled. If you change your information on this registration page, your user
information will be updated as well. So, please do not change any of your auto-filled
information unless you want to update your user information. Click “Continue” to complete the
registration.

IMPORTANT: Please do NOT use the “(Not {Your Name}, or want to register a different
person?)” link on this page. This will not create a registration for anyone. Instead, it sends a
confirmation email to the person whose name you typed. This will confuse the other person.
This will confuse the other person, and that person may also be able to modify your account
information on our website, so please do not use the link. We will remove this link in the future.
You will receive an email confirming your registration.

If an event is filled, the following message will be displayed when you click on the “CLICK HERE
TO REGISTER” link: “This event is currently full. However you can register now and be added to a
waiting list. You will be notified if a space for you becomes available.” 1If you want to be on the
wait list, click the “Register Now” button and follow the registration instructions listed above.
You will be added to the wait list and will receive a confirmation email. If someone cancels
his/her registration, people on the wait list will be added to the registration list in the order of
time registered, and a confirmation email will be sent the newly registered person.

You can view the list of classes for which you are registered. Click “My Account” on the left side
bar, and click the “View Contact Dashboard” link at the bottom of the page.

If you want to cancel your registration, please email us at info@Ilibrarylinknj.org or call us at

732-752-7720. You will receive an email confirming your cancellation. You cannot cancel your

registration online.
Please read our cancellation policy at http://www.librarylinknj.org/content/continuing-

education.

8. How do | get notifications about any announcements/news updates? How do |

stay connected?

Click the RSS feed icon listed on the very top right of the website and subscribe.
Become a Fan of our Facebook Page. Click the link on the right side bar on the Front Page.
Follow us on Twitter. Click the link on the right side bar on the Front Page.



|:| Guidelines for Using the LibraryLinkNJ Website: www.librarylinknj.org April 2011

Everyone who creates a user account on our website will also receive our online Newsletters.
Participate in the online forums (see more information on page 10.)

LibraryLinkNJ staff will send you emails about major Cooperative updates. Examples:
membership meeting announcements, new services, important library news that affects the
membership.

9. How do | update our library’s information?

Only the Primary Contact person listed on your library’s information page can update your
library’s information. A Primary Contact is a library staff member assigned by their library
director or administrator.

Search for your library on the “Member Search” page under “Membership” on the left side bar
menu, and check your library’s information. If your library’s primary contact is not correct,
please contact Mi-Sun Lyu (lyu@Ilibrarylinknj.org) as soon as possible.

If you are listed as the primary contact, please create your user account with the same email
address listed on your library’s information page.
Log into your account.
Click “My Account” link on the left side menu.
Click “View Contact Dashboard” text link at the bottom.
Click “Edit Contact Information” under “Your Contacts/Organizations”. This will load a different
website theme (layout).
Click “Edit” button under your library’s name. There are data fields that are displayed by
default.
IMPORTANT — Change or update only the following fields — leave the rest alone:
=  Contact Details
- Organization Name
- Phone
- Website
- Email LEAVE THIS BLANK. Your primary contact email address is managed
separately by the site admin.
= General
- Type 1
- Type 2
- School District (For school libraries only)
- School Grades (For school libraries only)
- Legislative District
- County
- Internet
- Consortium
- OCLCID
= Address
- Street Address; City; Zip; State
- Do not change Location Type or the “Primary location for this contact”
check box.
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- If you library is on the delivery service, you may see two address listed.
Update your library information
Click the “Save” button.
If any of the following information is incorrect:

= Delivery ID Number
= Delivery Frequency

= Voting Representative

Please contact Mi-Sun Lyu at lyu@librarylinknj.org.

10. How do | report our library’s monthly delivery service statistics?

You must be the primary contact of your library and must log in to your account to use the
online delivery stat report form.

Please go to the following page: http://librarylinknj.org/libraries

Search for your library in the “Member Search” page under “Membership” on the left side bar
menu, and check your library’s information. Note: all four search options use “AND” as the
search operator.

If your library’s primary contact is not correct, please contact Mi-Sun Lyu (lyu@librarylinknj.org)

as soon as possible.

If you are listed as the primary contact, please create your user account with the same email
address listed on your library’s information page.

Log into your account.

Click the “My Account” link on the left side menu.

Click the “View Contact Dashboard” text link at the bottom.

Click the “Edit Contact Information” under “Your Contacts/Organizations”. This will load a
different website theme (layout).

Click the “Monthly Delivery Stats” tab next to “Summary”.

Click the “Edit Monthly Delivery Stats” button and put the total number of items shipped that
month.

Click the “Save” button.

Important: Please read the delivery requirements on the “Delivery” page. Your library must
keep your daily log stat sheets for 12 months, and it is required that you report online each
month’s total number of items shipped. Daily log stat sheets are also posted on the “Delivery”
page.

11. Where can | print out a delivery label?

Click “DELIVERY” on the top menu bar.
Click the “Delivery Address List & Label Generator” text link.
Click the “Print Labels” text link next to the library for which you need the delivery label.
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The delivery address list is displayed alphabetically by library name. You can search for a library
by name, city, or delivery id. Note: all four search options use “AND” as the search operator.

If your library’s delivery information is not correct, please contact Mi-Sun at
lyu@librarylinknj.org.

12. How do | participate in the Forums?

Your Forum Posting Subject [T R e AT

You can either click “Forums” on the top menu bar, or “Create Content” on the left side bar.
Click “Post new Forum topic” on the Forum pages, or click “Forum Topic” on Create Content
page.

Type your subject in the subject box.

Choose a forum in the dropdown box.

Provide your contact information (This information is for user identification for forum postings
only and is NOT visible to the public).

Select a Forum Type and Categories.

Type your posting.

Click “Preview” We strongly recommend that you preview before you post.

Slick “Save” to post.

You can edit or delete your own postings. Click the ‘Edit’ tab on your own posting to edit or
delete. To edit, update your posting and click “Save” button at the bottom. To delete, click the
“Delete” button at the bottom.

You are logged in as carol2 | Edit ~ Log out

'f’ LibraryLinkNJ ¢ ) L E—

Search I

H » Forums » ANY TYPE OF LIBRARIES
carol2

AboutUs test topic

Board | Task Forces e 6 Ed|t

Continuing Education

bershi == — - i i

Membership UbraryLinkNs @ Your contact information
Projects lyu@infolink.org
732-752-7720

Library Community

MR oopE category —@_ Your posting topic category —

Create content Administration

Log out

Current forum L1/ OELC ew el :! forum type

This is the actual contents of this test posting. @ Your aCtua| pOStIng NeXt forum top|c |n th|s

. ? ANY TYPE OF LIBRARIES 1
type link = q gy manmentes :

Add new comment l—

If you post a topic to a forum and then realize that you selected the incorrect forum, click “Edit”,
change the forum and then check “Leave shadow copy” at the bottom right above the “Save”
button (This place a link in the old forum to the new forum.) Click the “Save” button.

If you want to add a comment to a particular forum posting, click the “Add new comment” text
link at the bottom right of the posting. Please be sure to include your library name and contact
information in your comment (This information is for user identification for the comments only
and is NOT visible to the public).

11
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e Once posted, you cannot delete your comment. Be sure to use the “Preview” button at the

bottom to review your comment and only then click the “Save” button. You can edit your own

comment by clicking the “Edit” text link below your comment. (See image on next page) Please
contact Mi-Sun Lyu at lyu@Ilibrarylinknj.org if you wish to delete your comment(s).

e If you want to make a comment on a particular comment, click “reply” below that comment.

About Us

Board | Task Forces
Continuing Education
Membership
Projects

Library Community
My account

Create content

Log out

Edit your own
comment

Other questions?

Lyrasis/OCLC new model

LibraryLinkNJ
coconnor@librarylinknj.org
732-752-7720

Forum Topic Category

Administration

TEST

Academic library directors have much on their plates to digest in the midst of the revamped model of service by Lyrasis and OCLC. We
have to stay on top of this for the membership.

Add new comment

Cheryl O'Connor

ANY TYPE OF LIBRARIES ~ ACADEMIC LIBRARIES &

» Add new comment

test comment

Make a comment to this comment,

this is a test.

not to the original posting above.

We are planning to implement exciting new features to the website and create other online services in

the future.

If you have any questions about or suggestions for our website, please contact Mi-Sun Lyu at

lyu@librarylinknj.org.




